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Stephen J Sugden
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Abstract

This is an update of an earlier paper [1], and is written for Excel 2007. A series
of Excel 2007 models is described. The more advanced versions allow solution of
f(x) = 0 by examining change of sign of function values. The function is graphed
and change of sign easily detected by a change of colour. Relevant features of Excel
2007 used are Names, Scatter Chart and Conditional Formatting. Several sample
Excel 2007 models are available for download, and the paper is intended to be used as
a lesson plan for students having some familiarity with derivatives. For comparison
and reference purposes, the paper also presents a brief outline of several common
equation-solving strategies as an Appendix.
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1 Introduction

Many algebraic equations cannot be solved by algebra; for example, 2x = x2. One
way to find an approximate solution to algebraic equations of the form g(x) = h(x)
is to accurately graph y = g(x) and y = h(x) as separate functions of x. Any points
of intersection will then be solutions. A better method, now that we have computers
to do all the tedious calculations, is to first express the equation in the standard form
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f(x) = 0, and then to determine points where the graph intersects the x—axis. This
standard form is usually obtained by transposing the function on the right to the left
side of the equation, that is, g(x)−h(x) = 0. Then we take f(x) = g(x)−h(x). For our
example above, we would have f(x) = 2x − x2.

We now consider the use of function plotting in Excel to locate solutions of f(x) = 0
to essentially any desired accuracy using a graphical zoom-in process. Automatic change
of colour of ordinates in Excel is used to drive the process.

1.1 Why construct a graph? How many solutions are there?

Some equations have just one solution: for example, 3x− 12 = 0. Other equations have
many solutions. For example, the equation sin x = 0 has an infinite number of solutions.
In other cases, there may be no solutions at all. A simple example of an equation with
no real number as solution is x2 + 1 = 0. Our example just above, 2x = x2, has three
solutions. Before attempting any computer-based solution method, it is always useful
to know if our equation has a solution or not! Usually, the best way see do this is to
construct a graph of y = f(x). In the case of x2+1 = 0, the graph will be entirely above
the x axis, so we know that there is no solution. In many instances, the graph will be
good enough to determine the solutions, provided we have some reasonably effi cient way
of isolating, or zooming-in on each solution. This is our aim in this paper.

1.2 What about algebra?

We have said that algebra is not adequate to solve some equations. Even if we can solve
a given equation by algebra or other method, it is always a good idea to have some
reasonably-accurate plot of the function before we start. This gives us some idea of the
general shape of the curve, and may also point out some region where problems may arise
for our particular method of solution. The graph of the function f(x) = (x− 2)(x− 5)
crosses the axis at x = 2 and x = 5. In this case, we can tell by inspection of the form
of the function that the solutions are 2 and 5. However, this is a rare luxury. If we draw
the graph of y = f(x), then from a geometrical point of view, we are looking for points
where the function intersects the x—axis.

1.3 Can we get f(x) to be exactly zero?

We wish to find a value of x such that f(x) = 0. For example if f(x) = x3 − 10x + 2,
then we are solving the equation x3− 10x+2 = 0 for x. It is important to note that, in
general, we are not expecting an exact answer for x, but one which makes the function
very small in magnitude (small, but could be either negative or positive). For example,
x = 3.05709 gives f(x) ≈ 5× 10−5, which may be small enough to accept this value of x
as a reasonable approximation to a solution. In the graphical method we consider here,
approximate solutions are what we seek. Occasionally we might get an exact solution
(we shall see that this occurs in our example, 2x = x2, where two solutions are integers,
and one is not).
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1.4 Simple function plotting in Excel

We want Excel to plot the graph of y = f(x) for us on a suitable interval a ≤ x ≤ b
with a minimum of fuss. Fortunately, with a few basic principles of spreadsheeting and
Excel’s charting capabilities, it is not too hard at all.

First, we need a table of ordered pairs (x, y). These represent points on the graph of
y = f(x). Excel is just perfect for generating these, and then it’s pretty reasonable at
plotting them too. In the language of multimedia and digital audio, we are sampling the
function (putting various values of xinto the function formula to compute corresponding
yvalues, and then tabulating them). Then, for plotting these points, we choose one the
scatter chart types. First, we consider a simple example, and then consider a more
flexible approach, which will allow us to easily change the plot interval for x.

2 Function plotting example

Let’s now graph the function y = x2 on the interval −3 ≤ x ≤ 3 in Excel. We use
just 30 points (actually 31 points if we want to have −3.0,−4.8, . . ., 4.8, 3.0; check this
carefully!). We now follow these steps.

1. Start with a new Excel worksheet.

2. First put the headings x and y in cells A1 and B1 respectively; make these two cells
centred and bold.

3. Now select the range A1:B32, click on the Formulas tab on the ribbon, then
Create from Selection. Excel will suggest that names be created from values
in the top row, which is just what we need. Click OK. It will create names x and
y, based on the top row, but the names refer to the respective ranges in columns A
and B, minus the heading (top row). If you want to see what has happened, click
on the drop down list arrow in the Name box (just above cell A1). Then, selecting
either x or y on this list will cause Excel to highlight the respective range.

4. Now put the value −3 in A2, the value −2.8 in A3, then select the range A2:A3,
grab the fill-handle and fill down to A32.

5. In cell B2, type the formula “=x*x” without the quotation marks. Double-click
on the fill-handle of B2 and watch what happens. Excel will fill up the column of
ordinates (column B).

6. We now have our table of (x, y) pairs, so we can get Excel to plot our graph. First,
it is advisable to select our tabulated pairs. There are easy and hard ways to do
even this! One of the simplest is to make use of the name box. Go to the name
box, select x; then hold down the CTRL key while going back to the name box
and selecting y.
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7. Now click on the Insert tab on the ribbon. We want a scatter diagram, so click
on the Scatter button, with the “Scatter with smooth lines” sub-option. Always
choose the scatter chart type for “y = f(x)”style mathematical function plots.

8. At this point you should have a standard parabolic graph. Select the text box
which says "Series1" and delete it.

9. You can re-size the graph to a more suitable size by selecting and then dragging
one or more of the re-size handles.

10. Your model should look something like Figure 1. Save it as 01 Simple plotting.xlsx.

Plotting this function in Excel was no problem, except that if we change our minds
on the plot interval, we must do most or all of those steps again! In the next section,
we consider an improved method.

x y
3 9

2.8 7.84
2.6 6.76
2.4 5.76
2.2 4.84

2 4
1.8 3.24
1.6 2.56
1.4 1.96
1.2 1.44

1 1
0.8 0.64
0.6 0.36
0.4 0.16
0.2 0.04

0 0
0.2 0.04
0.4 0.16
0.6 0.36
0.8 0.64

1 1
1.2 1.44
1.4 1.96
1.6 2.56
1.8 3.24

2 4
2.2 4.84
2.4 5.76
2.6 6.76
2.8 7.84

3 9

0

1

2

3

4

5

6

7

8

9

10

4 3 2 1 0 1 2 3 4

Figure 1: Simple Plotting

3 An improved approach to plotting y = f(x)

Our model is quite primitive, because if we wished to observe our function plotted
over a different interval, we need to mess around with the x values in column A. It is
preferable to set up some plotting parameters, as shown in Table 1. They are intended
to allow plotting of a function described by a single formula y = f(x) over the interval
a ≤ x ≤ b, using n subdivisions, of equal width, h. The parameter h is the step size,
i.e., the horizontal distance between neighboring values of x. This process generates an
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arithmetic sequence of values of x:

x0 = a+ 0h

x1 = a+ 1h

x2 = a+ 2h

. . .

xn = a+ nh = b

Here are the steps:

1. Type the headings a, b, n, h in cells C1 to F1 respectively. Make them centred
and bold like the x and y headings.

2. Select the range C1:F2 and click on the Formulas tab on the ribbon, then Create
from Selection. As in step 3, Excel will create names for your parameters, using
your headings as a guide.

3. In C2 type the value −3; in D2 the value 3; in E2, the value 30, and in F2 the
formula “=(b-a)/n”. The value 0.2 should appear in F2.

4. Now replace the first x value in A2 by the formula “=a”.

5. In A3, type “=”, click in A2, then type “+ h”. Double-click on the fill-handle for
A3 and the x values in column A will be updated. Now, to zoom in or out on a
plot, we just change the value(s) of a and/or b.

6. We now look at a different function. In B2 type the formula “=2^x - x*x”, then
double-click on B2’s fill-handle; Excel will fill column B with the new formula.

7. Now change the plot interval to a = −2and b = 5 by typing -2 in cell C2 and 5
in cell D2. Notice that the x and y values are automatically recomputed and the
graph re-plotted. We see that this function crosses the x—axis three times on the
interval −2 ≤ x ≤ 5.

8. Save your model as 02 Better plotting.xlsx. It should look something like Figure 2.

For this plotting model in Excel, we have a reasonable degree of flexibility. One thing
we cannot easily change is the number of sample points of the function; this is 31 here,
but this is often adequate.

4 Colour by numbers

We now give our model a very useful enhancement, with only a few more steps. Excel
has a feature called conditional formatting, whereby certain aspects of a cell’s format
(font, colour or border) may be made to automatically depend on the current value
stored in the cell. We can make good use of this feature by asking negative, zero and
positive values to all have different colours. Here are the steps.
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x y a b n h
2 3.75 2 5 30 0.233333

1.76667 2.82722
1.53333 2.00563

1.3 1.28387
1.06667 0.66036
0.83333 0.13321

0.6 0.299754
0.36667 0.641128
0.13333 0.893945

0.1 1.061773
0.333333 1.14881
0.566667 1.159986

0.8 1.101101
1.033333 0.97897
1.266667 0.801606

1.5 0.578427
1.733333 0.320507
1.966667 0.040862

2.2 0.24521
2.433333 0.51971
2.666667 0.76151

2.9 0.94574
3.133333 1.04318
3.366667 1.01948

3.6 0.83427
3.833333 0.44006
4.066667 0.218928

4.3 1.208311
4.533333 2.605197
4.766667 4.500238

5 7

6

4

2

0

2

4

6

8

3 2 1 0 1 2 3 4 5 6

Figure 2: Better Plotting

1. Go to the Name Box and select y.

2. Select the Home tab on the ribbon, and then click on Conditional Formatting.
Choose the first option: Highlight Cells Rules, then click on Equal To. A
dialog box will appear asking you to “Format cells that are EQUAL TO”. Just
type “0”in this box. Do not close this box yet– don’t click OK.

3. Now we use some pastel shades to automatically indicate the sign of y: light brown
or light orange for negatives, green for zero, and blue for positives (simple rationale:
underground, grass, and sky). In the drop-down list-box to the right of “with”,
click on the arrow and select Custom Format, and then choose a nice bright
green. Then OK, OK.

4. With the y range still selected, repeat step 20, except this time, choose Greater
Than. Type “0”in the box again, and then select a nice sky-blue colour from one
of the Custom Formats.

5. Repeat the previous step to get a third condition, Less Than, which you should
colour a light brown.

6. You will notice only blue and brown y values for the current function.

7. Now change the values of a and b to −3 and 3 respectively. Since the abscissa
x = 2 is now part of the list of values in column A, we have a highlighted cell (A27)
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where the function is exactly zero.

8. Now change the values of a and b to 2 and 5 respectively. We now see two integer
solutions: x = 2 and x = 4. It is clear that we can now look at the function over
pretty much any interval we want just by changing the values of a and b.

9. Save your worksheet as 03 Colour by Numbers.xlsx. It should look like Figure 3.

x y a b n h
2 3.75 2 4 30 0.2

1.8 2.95283
1.6 2.23012
1.4 1.58107
1.2 1.00472

1 0.5
0.8 0.06565
0.6 0.299754
0.4 0.597858
0.2 0.830551

2.8E16 1
0.2 1.108698
0.4 1.159508
0.6 1.155717
0.8 1.101101

1 1
1.2 0.857397
1.4 0.679016
1.6 0.471433
1.8 0.242202

2 0
2.2 0.24521
2.4 0.48197
2.6 0.69713
2.8 0.8756

3 1
3.2 1.05041
3.4 1.00394
3.6 0.83427
3.8 0.51119

4 0

4

3

2

1

0

1

2

3 2 1 0 1 2 3 4 5

Figure 3: Colour by Numbers (CBN)

4.1 Beware

A word of caution about computer graphs: beware. Any computer-generated graph is
derived from a finite number of samples of the function, e.g., in ours the function is
evaluated 31 times, and these y values (ordinates) are plotted against the corresponding
values of x. Since we are dealing with real-valued functions of a real variable, we have an
infinite collection of function values, even in the smallest interval. In some cases, some
interesting behaviour is masked by only taking a sample of these points. If you suspect
something is going on, but the graph does not reveal it, then one strategy is to zoom in
and get a closer look. Sometimes we need to zoom out, and get the big picture. In our
Excel model, zooming is controlled by adjusting the values of a and b, the end-points of
our plot interval.
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5 Using our model to solve f(x) = 0

By noticing a change of colour on the tabulated ordinates, we can quickly spot a region
where the function is zero. The only way for a function to change sign without being
zero in between is for it jump across the x axis. This will be the case if the graph of
the relationship y = f(x) is discontinuous. Such functions certainly exist, but we do not
consider them here. Therefore, if we spot a change of colour, we can be certain that our
function has passed through zero.

x y a b n h
2 3.75 2 4 30 0.2

1.8 2.95283
1.6 2.23012
1.4 1.58107
1.2 1.00472

1 0.5
0.8 0.06565
0.6 0.299754
0.4 0.597858
0.2 0.830551

2.8E16 1
0.2 1.108698
0.4 1.159508
0.6 1.155717
0.8 1.101101

1 1
1.2 0.857397
1.4 0.679016
1.6 0.471433
1.8 0.242202

2 0
2.2 0.24521
2.4 0.48197
2.6 0.69713
2.8 0.8756

3 1
3.2 1.05041
3.4 1.00394
3.6 0.83427
3.8 0.51119

4 0

4

3

2

1

0

1

2

3 2 1 0 1 2 3 4 5

Figure 4: CBN showing two solutions of f(x) = 2x − x2 = 0

Sometimes functions have “repeated roots”. This means that, at a certain value
of x, not only is the function zero, but so is the first derivative (and perhaps also
higher derivatives). Simple examples of this occur for y = xn when n = 2, 3, 4 . . .. We
normally look for change of sign of the function to find roots, but such repeated roots
can complicate matters. It will usually be obvious from the graph just what situation
we are dealing with.

Let’s now use our model to find the third solution of f(x) = 2x − x2 = 0.

1. Click on B2 and alter the formula for the function to be "= 2^x -- x^2". Double
click the fill handle for B2 to fill the new formula into all the y—values.

2. Change the value of a (C2) to be −3 and the value of b (D2) to be 5.
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This “bigger picture”shows us that there is a solution between -1 and 0. Your graph
should now look like Figure 4.

We still have our two integer solutions, viz., x = 2 and x = 4. This may be seen
both from the graph and also from the tabulated y values when x = 2 and x = 4, since
they are both green.

Between the cells B3 and B4, you should see a change of colour in the y column
between x = −0.8 and x = −0.6. This means that there is a solution between these
x values. Here is an important step: if we now change the values of a and b to −0.8
and −0.6 respectively, this will effect a zoom-in operation, on the region containing
the solution. Do this and see what happens! Your new colour change will be between
x = −0.76667 and x = −0.76333.

Note that we have this solution, by changing the values of a and b just once, in order
to effect a zoom-in operation. This operation can be repeated as often as desired to get
much greater accuracy.

Note also that no algebra has been required; merely typing the formula for f(x) in
cell B2, and double-click for fill-down. The rest is observation of graph and colours. To
do the zoom-in, we have to type in new values of a and b, but no algebra is required.

5.1 Comments

The technique just described works for essentially any continuous function, and not just
quadratics or polynomials. We call it Colour by Numbers. Except for pathological
cases, most common functions look linear on a small enough interval. This may be seen
by zooming in. The techniques described may be extended to determine maximum and
minimum values of functions, by examining derivative(s) of the function of interest. We
consider this in the next section.

6 Derivatives

Adding estimates of first and second derivatives to our model is quite simple. This helps
us to locate local maxima and minima, and points of inflection. We use estimates with
accuracy O

(
h2
)
. This means that the error diminishes roughly proportional to h2. The

estimates are:

f ′ (x) ' f (x+ h)− f (x− h)
2h

and

f ′′ (x) ' f (x+ h)− 2f (x) + f (x− h)
h2

In these formulas h is just the same h we have been using to separate our x values.Here
are the steps.

1. Select column B. Right-click and select Insert. Excel makes room for a new col-
umn. Now hit F4 to get another new column.
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2. Select both columns B and C and then click on the Data tab on the ribbon. And
then on the Group button. Our estimates of first and second derivatives will
occupy these two new columns. We can now hide the derivatives later if they are
of no interest.

3. In B1 type “dy/dx” and in C1 type “d2y/dx2”. The superscripted 2 can be achieved
by selecting the 2 and clicking on the Home tab on the ribbon, and then the Font
arrow and checking the Superscript box. In each of B2, C2, B32, C32 type the
word “estimate”. This reminds us that our derivatives are not exact. However,
if h is not too large, they will be quite accurate, as we have used second-order
estimates. Also, it will stop us from adding the derivative formulae to cells in
which it cannot be calculated, as both the formulae use values in the y—column
that are above and below the current cell.

4. In cell B3, type the formula “=(D4 - D2)/2/h” and double-click to fill down.

5. In cell C3, type the formula “=(D4-2*D3+D2)/h/h”and double-click to fill down.

6. Now select a cell with any y—value in column D. Click on the Format Painter but-
ton (visible from the Home tab on the ribbon), and paint the range B3:C31 with
this format. You will get the conditional formatting colours now for derivatives as
well as ordinates (y—values).

7. Save your worksheet as 04 Colour by Numbers with Derivatives.xls.

7 Automation of the model

While the model just presented does a reasonable job, we would like to get Excel to
automatically update a and b instead of the user having to key them. An extended model,
05 Colour by Numbers with Derivatives & AutoZoom.xlsm, is available for download. The
user simply selects a range of cells in column A, then clicks on the Zoom In button. A
Zoom Out button is also provided, which simply doubles the length of the plot interval,
while maintaining its midpoint.

This model has some VBA code to implement the Zoom functionality behind the two
buttons. For this to run, you need to set Macro Security appropriately before loading
the model. To do this, click on the Offi ce Button in Excel (the large circular button at
the top let of the Excel window). The click on Excel Options at the bottom right. Now
click on Trust Center and then Trust Center Settings. Then select the option Enable all
macros and click OK.

8 Closing remarks

Many other numerical methods exist to solve f(x) = 0, but whichever one is chosen, it
is usually best to graph the function so that an overall picture of its behaviour can be
seen. As we have noted, this can be done in a very straightforward manner in Excel.
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x dy/dx d2y/dx2 y a b n h
1 estimate estimate 0.5 1 5 30 0.2

0.8 1.999385 1.72361 0.06565
0.6 1.658773 1.68251 0.299754
0.4 1.326992 1.6353 0.597858
0.2 1.005354 1.58107 0.830551

0 0.695369 1.51878 1
0.2 0.39877 1.44722 1.108698
0.4 0.117546 1.36502 1.159508
0.6 0.14602 1.2706 1.155717
0.8 0.38929 1.16214 1.101101

1 0.60926 1.03755 1
1.2 0.80246 0.89444 0.857397
1.4 0.96491 0.73005 0.679016
1.6 1.09203 0.5412 0.471433
1.8 1.17858 0.32428 0.242202

2 1.21852 0.07511 0
2.2 1.20492 0.21112 0.24521
2.4 1.12982 0.53991 0.48197
2.6 0.98407 0.91759 0.69713
2.8 0.75717 1.351431 0.8756

3 0.43704 1.849784 1
3.2 0.00984 2.42224 1.05041
3.4 0.540364 3.07982 1.00394
3.6 1.231864 3.835181 0.83427
3.8 2.085669 4.702863 0.51119

4 3.125912 5.699567 0
4.2 4.380316 6.84448 0.739174
4.4 5.880728 8.15964 1.752127
4.6 7.663729 9.670362 3.091465
4.8 9.771337 11.40573 4.817618

5 estimate estimate 7

2

1

0

1

2

3

4

5

6

7

8

2 1 0 1 2 3 4 5 6

Zoom In Zoom Out

Figure 5: Colour by Numbers with Derivatives & AutoZoom

Numerical methods are typically iterative (they converge on a solution after series
of steps) and require an estimate of x to get started. This can usually be obtained by
inspection of the graph of the function, giving us yet another reason for having this at
our disposal.

As we noted earlier, graphing functions was extremely tedious and error-prone before
the advent of computers. With tools such as Excel so readily available, and assuming
that f(x) is a "simple-enough" function, there is really no longer any excuse for failing
to generate the graph of y = f(x) before attempting to solve f(x) = 0.
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9 Exercises

Use the supplied models to find all zeroes, local maxima and local minima of the following
functions over the given intervals. Find each point correct to 4 decimal digits by zooming
in.

1. y = 1− x+ 2x2 on −5 ≤ x ≤ 5
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2. y = 1 + x
√
8− x− x2 on 0 ≤ x ≤ 5

3. y = exx2 − 5 on −4 ≤ x ≤ 2

4.

y =

{
x+ 1 if x ≤ 2
5− x if x > 2

on −5 ≤ x ≤ 5.

5. y = x3 − x2 + x− 2 on −5 ≤ x ≤ 5

6.

y =

{
2x− 1 if 0 ≤ x ≤ 3
8− x if 3 < x ≤ 7

7. y = 1− 3/(x2 + 2) on 0 ≤ x ≤ 2

8. y = sin (1/x) on −1 ≤ x ≤ 1

9. y = |2x− 1|+ |x− 3| on 0 ≤ x ≤ 10

10. y = x3 − 3x+ 2 on −3 ≤ x ≤ 3

11. Solve |4x+ 5| = x2− 6x+2 for x. Use an algebraic method and an Excel method.

12. Solve x2 = 2x for x in Excel. Find all three solutions correct to six decimal places
each.

13. Use an Excel model to determine k so that the equation
√
x = kx + 20 has a

solution in 0 ≤ x ≤ 4, and find that solution correct to 4 decimal digits.
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Appendix: Some strategies to solve equations

We outline some ways of approaching the problem of solving f(x) = 0 for x.
Strategy 1: Guess a solution. This is also called trial and error. It is a technique

where you simply substitute selected values of x and see if you get zero. Of course, the
question of which values of x to select is left unanswered. This approach used to be very
tedious and error-prone, but now we have spreadsheets like Excel and it is very easy.
Though trial and error sounds very unscientific, it underlies many computer methods,
which conduct a (more systematic) search for x. Example: f(x) = x3 − 10x + 2. We
try x = 3 and get f(3) = −1 . We try x = 4 and get f(4) = 26. Neither of these is
zero, so we haven’t found a solution, but since the function changes sign as x goes from
3 to 4, then there must be a solution in between (probably a lot closer to 3 than to 4
—why?). We could build up a table of values of x with corresponding function values.
This is useful as we can observe "trends" and it leads to some of the other methods, as
described below.

Strategy 2: Algebra. This method will work for very simple equations such as 5x−
23 = 52, in this case leading to the solution x = 15. Although algebra is extremely useful,
we rapidly run into brick walls when we try to apply it to solve equations that occur
in many practical problems. Most models lead to equations which are not linear, and,
while it is possible to solve some more complicated (but very specialized) equations by
algebra, the majority of real-world problems do not yield to this approach. For example,
we can solve a quadratic equation by the algebraic process of completing the square, or,
what is really the same thing, by use of the quadratic formula (see below). Beyond this,
very little progress on solving equations can be made until so-called numerical methods,
i.e., computer-based methods, are introduced. Some of these are very briefly described
below.

Strategy 3: Use a special formula. The range of equations that may be solved
with this technique is extremely small. The most well-known is the quadratic. If we
wish to solve x2 − 7x + 12 = 0, then the so-called quadratic formula gives the solution
in terms of the coeffi cients:

−b±
√
b2 − 4ac
2a

In our case, application of this formula yields x = 3 or x = 4.
Strategy 4: Factorization. This is a variation of the algebraic approach and

relies on the fact that if two quantities are multiplied together and the result is zero,
then at least one of them must be zero. Thus, to solve (x− 3) (x+ 7) = 0 we can argue
that either (x− 3) or (x+ 7) must be zero. This means that x = 3 or x = −7. This
is a very fundamental and powerful technique, but it assumes that the function we are
dealing with can be factorized. Most functions cannot. For many problems, effort spent
in attempted factorization is better spent on other approaches.

Strategy 5: Construct a graph of y = f(x) and observe where y = 0. This
method extends the first strategy of trial and error. We select an interval (range of x
values) over which we wish to evaluate and plot (sample) the function. It is simple but
effective, and easily implemented in Excel.
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Strategy 6: Bisection method. This method also extends the first strategy of
trial and error. We construct the graph as in the previous method, and try to locate
an interval over which the function changes sign. We cut this interval into two equal
halves (bisect it) and then choose the half on which we still have a change of sign of the
function. This process is repeated until the interval is so narrow that any point in it will
serve as our answer. Again, the method is easily implemented in Excel.

Strategy 7: Newton’s method. This is a very powerful technique, usually giving
very high accuracy with only a few steps, but it requires use of derivatives. It is also
very easily implemented in Excel, provided we have some way of evaluating, or at least
estimating, the derivative (rate of change of the function). A sequence of iterates may
be generated by the formula:

xn+1 = xn −
f(xn)

f ′(xn)

We need to somehow find a starting value x0, and this is best done by inspecting the
graph of y = f(x) in Excel. Newton’s method may fail, but when it converges, it usually
does so with great speed.

Strategy 8: Secant method. This is a modification of Newton’s method so that
we do not have to compute derivatives. It is also easily implemented in Excel. Unlike
Newton’s method, the secant method requires two values to get started. We call them
x0 and x1. The formula for the secant method is:

xn+1 = xn −
f(xn) (xn − xn−1)
f(xn)− f(xn−1)
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